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Legal notices

To avoid making mistakes during operation, we recommend that you carefully follow the instructions provided 
in this manual.
We have taken a great deal of care whilst programming and checking this software.
Nevertheless, since it is not possible to guarantee totally error-free software applications in all environments 
and at any time, we unfortunately cannot rule out the possibility that some errors may have crept in.
MacroSystem Digital Video AG and its dealers therefore do not guarantee fault-free use of the product or 
complete flawlessness of the product.
 
We will remedy any errors in the program and supply the affected customers with the new software free of 
charge, if possible.
Warranty claims for defects shall expire in 24 months in the case of newly manufactured items. This shall not 
apply insofar as the law prescribes otherwise and in cases involving injury to life, limb or health, in the case of 
intentional or grossly negligent violation of duty on the part of the supplier and in the case of malicious silence 
with regard to a defect.
The customer shall report defects to the supplier immediately in writing. Claims for reimbursement of 
expenses for error tracing shall be honoured only after prior consultation with MacroSystem Digital Video AG 
management staff.
Any other claims asserted by the customer for any expense(s) required for the purpose of subsequent 
performance, in particular transport, travelling, work and material costs shall be excluded. However, this shall 
not apply to claims for reasons other than newly determined software defects.

Warranty claims shall not apply in the case of only insignificant deviation from the agreed quality, for only 
insignificant impairment of the usefulness, in the case of natural wear or damage which may occur after 
passage of the risk due to improper or careless handling, excessive use, unsuitable operating materials or 
which have occurred due to other special external influences not provided for in accordance with the terms of 
the agreement. In the event that improper modifications or repair work is performed by the customer or any 
third party, then any warranty claims for defects shall also be null and void for these and other consequences.

We do not, however, accept any liability for loss of data/time or any consequential damages that may occur 
as a result, particularly because we have no influence over correct software installation and operation by the 
customer. MacroSystem Digital Video AG and its dealers therefore cannot be held liable for any defects or 
unintentional damage in connection with the installation or use of the Photo-Studio software.

Claims by the customer to compensation in damages and/or reimbursement of expenses shall thus be 
excluded, in particular because of violation of contractual obligations and due to unlawful acts. However, this 
shall not apply insofar as peremptory liability is involved, e.g. in accordance with product liability law, in cases 
of intention, gross negligence, because of injury to life, limb or health or because of violation of substantial 
contract obligations. However, any claims to damages for violation of substantial contract obligations shall be 
limited to conventional foreseeable damage insofar as intention or gross negligence is not involved or liability 
due to injury to life, limb or health. A shift of the burden of proof to the disadvantage of the customer shall not 
be connected with the above regulations.

Neither MacroSystem Digital Video AG nor its dealers are responsible for any damages resulting either directly 
or indirectly through the use of the software or the operating instructions. This is particularly the cause for 
profit loss and reimbursement of expense.
Any implied guarantee is totally out of the question, including guarantee of suitability of the software or 
operating instructions for a particular purpose.

Please therefore ensure that you backup your video footage before using the device. We recommend that you 
do not delete the video footage and that you create a backup on DV tape beforehand.

Since it is possible that changes have been made to the software after the manual was printed, the functions 

shown and described in this manual might differ from the software.
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1. General

Thank you for buying “Photo-Studio” from your 
dealer.

We appreciate your confidence in us and hope 
that this product will meet your expectations. 

These instructions will explain the steps 
required to correct and edit your photos, create 
a slide show, track the camera across a photo, 
assemble a collage, etc.

We shall be happy to help you with questions 
and suggestions for improvements. 
For this purpose please contact us at the 
addresses or telephone numbers shown in the 
Casablanca manual. 

Please have the serial number of your machine 
or your customer number ready whenever you 
contact us.

2. Installation / Starting the 
program

SMART EDIT system version 3.6 is a minimum 
requirement for installing the “Photo-Studio” 
software. 
Leave the Casablanca switched on and select 
the “Install product” button in the “System 
settings”, so that the appropriate window 
opens. 
If you are installing from a SmartMedia card, 
insert the card into the Casablanca drive with 
the gold contacts downwards and the cut-off 
corner first, on the left (pointing towards the 
Casablanca). 
If the “Photo-Studio” software is on a CD/DVD 
and if your system has a DVD burner and “DVD 
Arabesk” software, open the drawer and insert 
the CD/DVD in the burner. 

After a moment you will see that the”Photo-
Studio” software is listed in the “Install 
product” window. (If installing from a CD/DVD, 

drive noise may be heard, which indicates that 
the system is reading the CD/DVD). Select it 
from the list and click “Activate”.
A box will appear in which you must enter the 
product key obtained from the dealer. You will 
then see a message that installation has been 
completed, so you can remove the SmartMedia 
card or DVD. The printer driver will be installed 
automatically. The Casablanca system will then 
restart.

If you want to install “Photo-Studio” as a 
demo version, select it from the list and click 
“Activate” . Then click the “Demo”  button in 
the product key window. 
The word “Demo” will appear after the program 
name. Confirm with “Ok” and remove the 
SmartMedia card or CD/DVD. 
“Photo-Studio” will be available as a demo 
version after the system has been restarted. 
You can generate e.g. animation with the demo 
version, but its processing will be marked with 
a “Demo” label. The “Print” and “Export” 
functions will also be greyed out. 

After the system has been restarted, you will 
see the program “Photo-Studio” on the ”Edit” 
menu, listed alphabetically under “Special”. 

N.B.: To use the “Photo-Studio” program print 
function, you will need the printer which is 
also used for the “Caladan” program, e.g. the 
HP 5150. Please ask your dealer for further 
information. 
However, the “Caladan” program is not required 
for running the “Photo-Studio” print function.

3. What is Photo-Studio?

PhotoStudio is a program which enables you 
to produce attractive presentations of digital 
photographs, e.g. in the form of a slide show, 
for the first time. Until now, it has only been 
possible to load your digital photos into a 
Casablanca and edit them as a video sequence, 
but “Photo-Studio” now provides separate 
software dedicated to the editing of digital 
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photos, exploiting their high resolution.

Remove flaws from pictures, crop your 
photographs to size, adjust the colour, assemble 
collages and print them, animate your pictures 
by generating a camera track across a single 
photograph, put a slide show together, etc. etc. 
There are no limits to your imagination.

You can then watch your edited photos in an 
attractive form on your monitor and burn a DVD 
for your friends.

4. Useful tips

• Only photos in DCF format are exported.

• A PhotoFormat memory card is required. 
Casablanca SmartMedia cards are not suitable.

• “Photo-Studio” is designed for editing 
photographs taken by digital cameras. There 
may be restrictions if pictures are edited on a 
PC.

5. Operation

Start the program by running “Photo-Studio” in 
the upper part of the special effects (Edit menu) 
window and click the “Start Photo-Studio” 
button. The following main menu window will 
then appear:

The individual functions of this menu are listed 
and explained below:

5.1 Memory card

You will see the “Import” button under 
“Memory card”. Selecting it will open a new 
menu window.

Now insert a photo memory card in a drive of 
your choice (Casablanca SmartMedia drive, card 
reader, etc).

5.1.1 Photo list
The list is shown in a number of menu windows. 
It is therefore only described here.

Several pictures can be displayed at the same 
time in the upper part of the menu window. 
If there are more pictures on the list, you can 
scroll through it with the aid of the scroll bar 
located on the right-hand edge of the picture or 
by using the arrow buttons. You can select the 
drive where your photocard is located with the 
“Memory card” selection button underneath. If 
you have not connected an external card reader, 
the button will be greyed out and “Internal 
SmartMedia drive” will be the default.
After the system has accessed the memory 
card, all the photos present on the card will 
automatically be displayed on the list.

N.B.: Although the list also appears in other 
menu windows, only the photographs already 
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loaded are displayed there (5.1.3 Edit images).

5.1.2 Mark images
This option is repeated on other menus, so its 
individual functions are only described once 
here.

Under the option “Mark images”, you must first 
apply marks, as the other settings on this menu 
relate to the pictures which you have marked 
on the list. Proceed as follows: Click the desired 
photo on the list and then on the button for the 
function to be run.

- “Mark actual image”: The photo on which you 
clicked will be marked with a small green flag 
in the top left-hand corner. You can also mark 
several pictures consecutively.
- “Remove actual mark”: The marking on the 
photos previously selected will be removed 
again. 
- “Mark all images”: All the pictures on the list 
will be marked without the photos having to be 
preselected.
- “Remove all marks”: You will delete all the 
markings applied by clicking this button.

Note: If no picture is marked, the active picture 
in the frame will be edited. If at least one picture 
is marked, only this picture will be edited, 
but not the active picture, unless it is marked. 
However, there is an exception, which will be 
found under 5.2.2 Retouch.

5.1.3 Edit images
- “Get images”: The pictures previously marked 
will be loaded into your Casablanca machine 
by clicking this button. The pictures loaded will 
then appear in other menu windows on the 
Photo list. (c.f. 5.1.1 Photo list). 
N.B.: The number of pictures is not restricted, 
but the memory capacity is. You can load a 
maximum of 128 MB into SMART EDIT 3 and 
a maximum of 256 MB into SMART EDIT 4. 
The number of photos thus depends on the 
photograph (megapixels and quality).

- “Delete from card”. Clicking this button will 
delete the marked photo(s) from your memory 
card permanently after a warning message. How 
to mark photos is described under 5.1.2 Mark 
images.

5.1.4 Info
This button appears in many menu windows, so 
its functions are only described once here.

Clicking the “Info” button will open a new 
window.

In the upper part, you will see the Photo list, 
below which are the “Mark actual image” and 
“Remove actual mark” buttons, so that you can 
also change the markings again in this menu 
window.

You will find information on the photograph 
displayed above in the lower part of the menu 
window. The description of the photo (which 
you can enter yourself under 5.2.1 Format), the 
size of the photo, the date on which it was taken, 
the name of the camera and the file size will 
be displayed. Please note that the information 
provided and its extent depend upon the camera 
used.
Close the “Info” menu window with the “Close 
info” button to return to the “Import” menu 
window.

5.1.5 Preview
This option appears on many menus, so its 
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individual functions are only described once 
here. 

Clicking the “Preview” button will open a new 
window. 

In the upper window you will first see the active 
photo from the list displayed in miniature 
format, but the view will be enlarged in a few 
seconds.
You can scroll through the whole Photo list with 
the “Previous image” and “Next image” buttons 
underneath it. 
You will see the “Image number” and the total 
number of photos on the right, where e.g. “5/
10” means that the fifth of a total of ten pictures 
is being displayed. There are three further 
buttons at the bottom of the screen with which 
the photo displayed above can be marked or its 
marking removed and the menu window closed 
again, in order to return to the “Import” menu 
window. You can remove the memory card after 
importing.

5.2 Editing
“Edit” includes several options which are 
explained in more detail in the following 
sections.

5.2.1 Format 
Clicking “Format” will display a new menu 
window similar to the “Import” menu window, 
The Photo list above, the “Mark images” area 
and the “Info” and “Preview” buttons involve 

the same functions as the “Import” menu 
window. Please refer to these sections for 
further information.
Please note that only photos which have 
previously been imported will be displayed here.

In the “Format” menu window, you will see 
the “Description” button under the Photo list. If 
you click the text box alongside, the keyboard 
familiar to Casablanca users will appear 
alongside and you can use it (or an external 
keyboard), e.g. to enter a name for the photo.

You will also see the option “Edit images”, 
which, however, differs from the option of the 
same name in other menu windows.

- “Crop”: Click the “Crop” button to display the 
photo in large format. You can then move the 
cursor on to the dotted frame so that it turns 
into a double-headed white arrow. Then click 
the left-hand trackball button and move the 
trackball towards the centre of the picture, so 
that photo is cropped at the edge which you 
have selected. This works on all four sides and 
corners. In the background you will see the 
“cropped” part of the picture, darkened. Click 
the left trackball button to confirm the changes. 
(Clicking the right-hand trackball button would 
cancel cropping). 
N.B.: Please note that the margins are frequently 
not visible if the picture is displayed later on a 
TV screen. Do not crop too much of the photo. 

You can also move the section selected by 
moving the cursor inside it, so that it turns into 
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a hand. Then click the left-hand trackball button 
and move the trackball until you have reached 
the desired position. Following confirmation 
with the left-hand trackball button, you will see 
that the content of the picture has changed, 
due to the new position. If you would now like 
to undertake “fine cut” (e.g. in order not to cut 
off a head), click the left-hand button below, to 
display a tick. Then place the cursor on another 
edge of the picture and click the left-hand 
trackball button. You will see that the view will 
be zoomed in instantly to the point which you 
have selected, so that you can crop accurately. 
After you have established the position of the 
frame and confirmed it by click the left-hand 
trackball button, the picture will be displayed 
in full again. Exit from the menu window by 
clicking “Ok” to adopt these settings and return 
to the “Format” menu window. The menu 
window can be exited without adopting the 
cropping of the photo by clicking “Cancel”.

- “Rotate”: Clicking this button will allow you 
to rotate all the photos previously marked 
(in green). If no photo has been marked, the 
currently active photo (in the frame) will be 
rotated. 
After you click the “Rotate” button, a window 
will appear in which you can select whether 
the photos are to be rotated clockwise or anti-
clockwise by 90° or by 180°. Clicking “Cancel” 
will close the window again.

- “Copy”: If you click this button, all the photos 
previously marked will be copied and thus 
appear twice in the list above. If no photo is 
marked, the currently active photo (in the frame) 
will be copied. Several details from a single 
original can thus be used.

- “Delete”: Clicking this button will remove the 
currently marked photos from the list (and thus 
from the Casablanca) after a warning message. 
If no photo is marked, the currently active photo 
(in the frame) will be deleted.

5.2.2 Image processing
The “Edit images” option in this menu window  

includes the following functions:
- “Control images”: Clicking this button will 
open a menu in which you can make a variety 
of picture and colour corrections to the active 
photo (in the frame). 

The marked or, if no or several photos are 
marked, the active photo, will be displayed in 
the upper part of the menu window. You will see 
three symbols at the left-hand edge, with which 
you can toggle between different modes. If you 
click the upper symbol, you can set brightness, 
contrast and colour saturation as percentages. 
The middle symbol allows the gamma value 
to be adjusted as a percentage and the lower 
symbol allows the colours red, green and blue 
to be specified as a percentage.
If you have created a filter which you want to 
use again later, you can save it by clicking the 
“Archives” button. Click the “Save” button and 
then enter a name for the filter. The “None” 
button will enable you to restore the photo to 
its original state. (This will also work if you have 
already confirmed a filter and open the menu 
window again.).
Exit from the menu without making a setting 
with the “Cancel” button. Click “Ok” to confirm 
the specified filter.

If you have specified one or more filters and 
have saved them in the archive, you can use 
them later for as many other photos as you 
wish.
Mark the desired photo(s) first and then 
click ”Control images” again to retrieve the 
“Archives”. If you click “Load”, a window will 
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open in which you will see the photo to be 
edited on the left. The list of your archived filters 
will appear on the right. You can select the 
desired one. You will see that the filter will be 
applied to the right-hand side of your photo to 
give you an impression of the result.

Clicking “Ok” will apply the filter previously 
selected to the photo previously marked.

- “Retouch”: You can retouch the active photo in 
the frame (not the marked photo), e.g. remove 
a flaw, with this function. When you click this 
button, the active photo will be displayed in 
large format. A text on the lower edge of the 
picture will prompt you to select the detail to be 
changed. You will see a cross in a box, which 
will first be located in the top left-hand corner 
of the picture. Move the trackball to draw a 
frame around the detail (i.e. the flaw in the 
picture). The size of the box cannot be changed. 
Confirm the new position of the box by clicking 
the left-hand trackball button. The display of 
the selected detail will be enlarged and a new 
button bar will appear at the bottom of the 
window.

The two left-hand buttons on this bar will move 
it to the opposite edge of the screen and reduce 
its size.
Clicking the framed colour box will open a 
window in which you can specify a retouching 
brush. Pre-defined square brushes are shown in 
the upper row and round brushes in the lower 
row. Select the desired brush by clicking the 
appropriate box and specify any appearance 
by using the attributes “Blur” and “Size”. You 
will see a “Preview” of the settings made on 
the right-hand side. If you have created a brush, 
confirm the selection by clicking “Ok”.

You can now determine whether your copying 
brush is to be “relative” (i.e. the selected 
source area to be copied remains at the same 
distance from the target area to be retouched) 
or “absolute” (the source area to be copied is 
to remain stationary). When you have selected 
a function and clicked on the corresponding 
button, you will see a green mark with a stamp 
symbol. Move the trackball until the symbol is 
located over the area to be copied and confirm 
this selection by clicking the left-hand trackball 
button. When the symbol has disappeared, 
move the ball until the red mark is over the 
area to be retouched (the flaw). When you have 
reached the desired position, click the left-hand 
trackball button and then move the ball to and 
fro so that the selected area is copied. You can 
stop the copying process by clicking the left-
hand trackball button again. You can now select 
another point to be retouched and continue 
copying. Then select the button bar by clicking 
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the right-hand trackball button again. Clicking 
the “Save iamge” option will save the changes 
which you have made to the picture. Exit the 
menu window by clicking “Exit”. Only the 
changes already saved will be adopted.

5.2.3 Animation
This function makes it possible for you to add 
an animated camera track across your photo, so 
that it looks like a video clip. 
Clicking the “Animation” button will open a 
window in which you can select one of the 
photos listed. If you confirm the selection with 
“Ok”, a new menu window will open.

Your selected photo will be shown in large 
format with a box superimposed on it containing 
a point representing the detail of the later 
camera position. If you want to change the size 
of the box in proportion (the smaller the box, 
the further the zoom into the picture), place 
the cursor on one of the four corners, so that a 
double-headed white arrow appears. Now click 
the left-hand trackball button and move the ball 
until the desired size is reached. During this 
process, you will see the enlargement/reduction 
factor at the edge of the screen. It does not 
matter if the factor increases although you are 
reducing the size of the box. As the box will fill 
the screen during tracking, the factor will show 
the enlargement in the box. The smaller the box, 
the larger the display inside it. 
Note: As pictures from a digital camera have 
higher resolution than TV images, your photos 
will retain TV quality if you zoom in. However, 

the limit is factor 1, as this is where video quality 
is reached. The quality will deteriorate at a 
higher factor.

To define the route of the track, you must first 
specify the starting point.

To do this, click the symbol inside the box so 
that it turns blue and move the ball until the 
box is located in the desired position. Clicking 
the left-hand trackball button will turn the point 
green again, locking the box in place. The 
position and size of the point can, of course, 
also be set using the button bar described below 
(under the “Waypoint” option). You will see that 
another (yellow) symbol will appear on your 
picture. connected to the starting point by a 
green dotted line.

This symbol represents the end and the line 
represents your later camera track, which you 
will, of course, wish to change.

You can now concentrate on the button bar 
which is superimposed on the photo, but was 
not displayed while the box was being placed.

Use the two buttons located on the left to reduce 
the size of the bar or to move it to the opposite 
edge of the screen. 

You will now see the “Camera move” option. 

- “Settings”: Clicking this button will open a 
window in which you can make various settings 
for the active (green) part of the track. 
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The “Pause in” and “Pause out” buttons 
are used to determine how long the camera 
will dwell on the detail of your photo at the 
beginning and end of the active part of the track. 
You can use the “Accelerate” and “Slowdown” 
buttons to set how quickly the camera should 
accelerate or decelerate between stationary and 
movement.. If you select the “---” function, no 
setting will be made. 
The “Motion length” button determines the time 
the camera will require to track from one point 
to the next on the active part of the track.

You can also add pivots to your track. Pivots are 
used to set the path of a track, e.g. to add an 
additional curve. No further adjustments can be 
made to pivots. To add a pivot, simply click the 
point on the track where you want it to appear. 
Then move the trackball until the pivot is in its 
desired position and confirm it by clicking “Ok”. 
A pivot is deleted by placing the trackball cursor 
on it and clicking the right-hand trackball button.

- “Append new”: Clicking this button will add 
another point beyond the end point of the track. 
The newly-added point will be green and the 
most recently active yellow. Every additional 
new point will always be added behind the one 
most recently active. You will see that the part 
of the track behind the green point is shown 
as a dotted green line. Add points until you 
have created the desired number and place the 
individual points wherever you wish, simply by 
clicking them and moving them. You will see 
that a box is drawn around each new point while 
it is active. Of course, you can vary the size of 
the box from point to point. If you have created 
several tracks, clicking on one point will activate 

the part of the track which starts at that point.

- “Remove”: If you want to remove a point, 
activate it and then simply click this button. The 
point can also be inside the track. Its position is 
immaterial.

The next option is “Waypoint” and includes the 
following functions:

- “previous” and “next”: By using these two 
buttons, it is possible to jump along the track. 
The buttons always start from the currently 
active point. You can also click these points 
directly, as an alternative to using these buttons.

- “Edit”: You can access a new button bar 
by clicking on this button. You will see the 
current picture content of the active point in the 
background.
Click “Position” to determine the position of a 
point. Simply move the trackball and confirm 
the new position by clicking the left-hand button 
To adjust the size, click the “Zoom” button and 
move the ball. The factor shown at the edge of 
the screen is an aid. The higher the zoom factor, 
the larger the display in the box. Please note that 
quality declines from a factor >1. 
Then exit from the “Edit” menu window by 
clicking “Ok”, to assume the settings made. 
Click “Cancel” to exit from the menu window 
without making any settings.

- “Preview”: By using this button you can 
preview the track to make any corrections.

- “Process”: You can make your Casablanca 
process the animation here, which may take 
some time, depending upon the length of the 
camera track.

- “Length”: Here you can read off the length of 
the full camera track/animation.

Exit from the “Animation” menu window by 
clicking the menu symbol in the lower right-
hand corner. In this case, cancelling with the 
right-hand trackball button is not possible, to 
prevent accidental cancellation.
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When you have exited from “Photo-Studio”, 
you will see the processed animation in the 
scene bin of the “Edit”  menu window. 

If you open the “Animation” menu window 
from another photo, a warning that the previous 
settings will be lost will appear.

5.2.4 Collage
You can use this menu function to create a 
collage from several of your photos. If you click 
this button, a window will open which contains 
a button bar and a white box.

- “New image”: Click this button first. A window 
will open in which you can select a photo from 
your list. A cross with a small box will appear 
after confirming with “Ok”. Move the trackball 
until the cross (representing the upper left-hand 
corner of the picture) has reached the desired 
position and confirm the selection by clicking 
the left-hand button. Now move the ball again 
to set the size of the box and thus the position 
of the lower right-hand corner, then confirm 
it. You will then see that the box drawn will be 
filled with the photo which you selected. If the 
proportions of the photo do not match those of 
the box, the picture will be partly cropped, to fill 
the box completely.

Of course, you can also move the boxes directly. 
To do this, activate a box and click the left-hand 
trackball button as soon as the screen cursor 
has changed into a hand. A cross will now 
appear and you can move the ball until the box 

has reached its desired position, which you 
can confirm by clicking the left-hand trackball 
button. Of course, you can also modify a box 
later by clicking directly on its sides or corners.

- “Delete image”: Of course, you can delete 
photos which have already been inserted. 
To do this, click this button, so that a prompt 
appears asking whether all the photos or only 
the active photo are to be deleted. After making 
the selection, both the desired picture and the 
relevant box will be removed.

- “Edit image”: Clicking this function will display 
a new button bar. Clicking “Change image” will 
display the Photo list, from which you can select 
the picture to place in the selected box instead 
of the previous picture.

Clicking “Rotate image” allows you to rotate the 
active picture. If you move the trackball to the 
right, the picture will rotate to the right. If you 
move it to the left, the picture will rotate to the 
left. The angle will be displayed at the edge of 
the screen.

Clicking the “Border” option will display a 
button bar, in which you can make adjustments 
to the frame. Clicking the framed colour box 
will open the “Palette” window, which will be 
familiar to users of the “Caladan” and “Akaba-
New Concept” programs. This window contains 
a selection of colours, patterns and shades with 
which you can vary the appearance of the box.
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 You will see the three areas of “Solid”, “Color/
Pattern” and “Bleed”.

You can toggle between these functions by 
using the appropriate buttons named above in 
the respective area. The active button will turn 
blue. Toggling will then take place automatically 
when a corresponding option is selected. The 
preview window located in the upper left-hand 
corner shows the result currently selected.

Under “Solid” you can select one of the six 
predefined “inkwells” making it possible to 
change between frequently-used colours quickly. 
Open the paint box with the “Change color” 
button to define a new colour. If you click “Ok” 
in the paint box, the colour of the current inkwell 
will be replaced by the one just defined.

In the “Color/Pattern” area, use the “Select 
pattern” button to choose the image pool from 
which you want to select a pattern.

Note: No pattern will yet have been selected if 
you have just installed Photo-Studio. Click the 
“Color/Pattern” button in the “Palette“ window 
to open the image pool directly, from which you 
can select a colour and pattern. After you have 
made a selection for the first time, the “Color/
Pattern” button will change to the Preview 
window. You can now open the image pool with 
the “Select pattern” button.

You can set shading under “Bleed”, in a process 
similar to the image pool. However, you can also 
set a shade direction by clicking “Direction”. 
The direction is selected by automatically 
placing a guideline in the video image, so 
that the direction can be matched to certain 
specifications. The initial and final colour may be 
freely adjusted, including alpha transparency.

When you have selected a colour or pattern, 
close the window by clicking “Ok”.

You can then set the “Border width” in mm and 
the “Blur” of the frame as a percentage, and exit 
from the “Border” menu window by clicking 
the symbol in the bottom right-hand corner or 

clicking the right-hand trackball button.
Please note that the mm measurement refers to 
the subsequent printout and not the display on 
the TV screen.

Clicking the “Shadow” button in the “Edit 
image” option of the “Collage” menu will 
display a new button bar. You can open the 
paint box by clicking the coloured box to specify 
a shadow colour, select one of eight possible 
directions in which the shadow can fall by 
clicking the “Direction” button and use the 
slider to set a “Distance” for the shadow. If you 
move the slider fully to the left, the shadow will 
be “off”. Then exit from the “Shadow” menu 
and the “Edit picture” button bar by clicking the 
menu symbol. 

- “to front” and “to back”. If the boxes overlap, 
you can use this button to specify which box is 
to be in the foreground and which one in the 
background. If there are already several boxes in 
the collage, the buttons can be clicked until you 
obtain the desired sequence. 

- “Settings”: Clicking this button will open a 
window which will be familiar to users of the 
“Caladan” program.

Clicking the “Snap to grid” function will activate 
an invisible grid. This makes it possible to align 
the edges of boxes with an invisible grid during 
generation, making positioning easier. Click the 
box again to uncheck it and thus remove the 
grid.
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The “Grid distance” slider is used to determine 
the distance (in mm) between the lines of the 
invisible grid.

If you check “Snap to images and auxiliary 
lines”, the boxes can be better positioned, as 
they will be aligned automatically with the 
specified lines or lines of an existing box. This 
option is comparable to the “magnetic grid 
lines” or “axes”, familiar from PCs. 
You can use the “Image-Snap threshold” slider 
to set the distance between the edge of a box 
and the gridline in order to “snap” (be placed) 
on to it,  in pixels.

You can open the paint box by using “Auxiliary 
line colour”, with which you can determine the 
colour of the guidelines, whereby the guidelines 
defining the outer limits in the collage will be 
shown. None of the pictures placed outside the 
guidelines will be printed or included in the later 
scene. The gridlines will not be visible in the 
scene or printout later.

- “Print”: Click this button to start printing the 
collage previously created.
Printing will only be possible if you have a 
suitable printer (see paragraph 2).

- “Create”: You can create a scene from your 
previously-created collage here. When you click 
this button, a window will open in which you 
can set the desired length of the scene. When 
“Ok” is clicked, the scene will be processed and 
will appear in the scene bin of the “Edit” menu 
window. 

Then exit from “Collage” by clicking the menu 
symbol. Clicking the right-hand trackball button 
is not possible in this case, to prevent accidental 
cancellation.

5.2.5 Gallery
You can use this menu to generate a slide show 
from your individual photos. Clicking this button 
will open a menu window, in the upper part of 
which you will see the list of your photos. 

Your later slide show will be shown on a 
storyboard in the lower section, similar to the 
storyboard of the final show. You can scroll or 
jump along this storyboard by using the controls 
below it or the arrow buttons.

- “Insert”: Clicking this button will insert 
the active photo from the above list into the 
storyboard. If the first photo in the storyboard 
is active, the familiar storyboard prompt will 
appear, asking whether the new photo should be 
added at the beginning or the end.

If the new photo to be added is an edited photo 
or one of a different size, clicking the button 
will open a selection window in which you can 
adjust the photo to video size. There are four 
ways of doing this:
If you click “White border” or “Black border”, 
the whole photo will remain visible. Borders 
have to be created for this purpose, which will 
be shown in white or black. Clicking “Crop 
to size” will adjust the photo by cropping the 
edges.

If you select “Scale to size”, the picture will be 
shown in full, but its proportions will not be 
retained.

- “Replace”: Clicking this function will replace 
the active photo, the pattern or colour on the 
board with the active photo on the list. If the 
new photo is not the same size as the one to be 
replaced, please refer to “Insert” for instructions 
on how to adjust it.
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- “Remove”: Clicking this button will delete 
the active photo from the storyboard without a 
prompt.

- “Length”: Clicking this function will display a 
slider with which you can adjust the length of 
the active photo on the storyboard.

- “Create”: When you have created your 
complete slide show, you can click this button. 
A prompt will appear with which you can 
specify whether a scene is to be created for 
each picture. This will make it possible for you 
to add dissolves (to the individual photo scenes 
inserted in the storyboard) in the “Transitions” 
menu window later. If you cancel the function, 
the whole slide show will be processed as one 
scene.

After you have processed your slide show, exit 
from the menu window by clicking the menu 
symbol in the bottom right-hand corner. Clicking 
the right-hand trackball button is not possible 
in this case, to prevent accidental cancellation. 
After exiting from “Photo-Studio”, you will find 
the processed slide show in the scene bin of 
the “Edit” menu window. Now add the scene(s) 
to the storyboard and add any dissolves in the 
“Transitions” menu in order to give your slide 
show the “finishing touch”.

5.3 Miscellaneous

The “Miscellaneous” option includes various 
functions, which are explained below:

5.3.1 Print, Export
Clicking this button will open a new menu 
window. You will see the Photo list in the upper 
section and the familiar options “Mark images”, 
“Info” and “Preview” in the lower section.
You will find the following functions under the 
“Export images” option:

- “for other programs”: Clicking this button 
will open a window  which gives you a choice 
between “Save” and” Delete”. Clicking “Save” 

will open the Casablanca archive, where, 
for example, you can access the “Caladan” 
program. You can save under any name. You 
can remove photos already saved on the list by 
clicking “Delete”.

- “to memory card”: If you click this button, a 
window will be displayed which will give you 
the choice of a “Memory card” on which the 
desired photo can be saved, provided that you 
have connected a card reader. (Otherwise the 
Casablanca SmartMedia drive will be the default 
setting). “Image quality” can then be selected. 
After you have made these settings, click “Ok” 
to save the marked photos on the desired 
medium.

- “Print”: When you have clicked on this button, 
the photos previously marked will be printed out 
in order. If the printer will not start, a warning 
message will be displayed, asking you to check 
all the cables, the paper and cartridges. If you 
have only installed the demo version of the 
Photo-Studio program, you will be unable to use 
the print function.

- “Printer settings”: A window will appear in 
which you can select the format of the printout 
(15 x 10, 18 x 13 or 29 x 20). You can then set 
the brightness, contrast and colour saturation 
settings as percentages.

5.3.2 Info
Clicking this information button will display 
information on the program version. 

6. Tutorials

The following tutorials are provided for a 
better understanding of, and a stage-by-stage 
introduction to, “Photo-Studio”. The examples 
are progressive. You should work through them 
in order. Only the first tutorial explains exactly 
how to start the program or open the individual 
menu windows.
Not all the buttons in the individual menus 



16 17

are explained in the examples. Please refer to 
Section 5. Operation for explanations of each 
button.

6.1 Editing a photo

This tutorial will teach you the basics of the 
program and how to edit an individual picture.
Open the “Edit” menu window of your 
Casablanca, click “Special” and find the “Photo-
Studio” program, arranged alphabetically in the 
upper part of the list. After you have activated it, 
“Start Photo-Studio” will appear to the right of 
the button and you should select it. 
The main program menu will then appear. 
Now insert a memory card containing your 
photos in the desired drive (e.g. in a connected 
card reader). 
Then click the “Import” button in the top left-
hand corner, to display a new menu window. 
You can use the “Memory card” selection button 
to set the type of your card, so that the pictures 
on the card are displayed in the top part of the 
menu. 
Now click the photo which you wish to edit (e.g. 
a group photo), so that it appears in a frame. 
Then click the “Get images” button so that the 
photo will then be loaded into the program.

Clicking the “Info” button will provide you with 
information on the current photo.

Exit from the menu window by clicking the 
menu symbol located in the bottom right-hand 
corner by clicking the right-hand trackball 

button. Then click the “Format” button in the 
main menu window.
You will see that only the loaded picture is 
displayed in the Photo list in the top section. 
If you want to give your photo a title, click the 
text box next to “Description” to display the 
keyboard with which you can enter a name 
for the photo. Of course, you can also use an 
external keyboard.

As you have only loaded one picture, it is not 
necessary to mark it for further editing. All 
further steps will automatically relate to this 
photo.

If your photo is shown the wrong way round, 
click the “Rotate” option. A window will open 
in which you can decide whether the picture 
should be rotated by 90° clockwise or anti-
clockwise, or by 180°. The photo will appear in 
the desired position after you have made your 
selection.

You can then click the “Crop” button to select 
one person from the picture and “airbrush” the 
others out.
Your photo will now be displayed in large 
format. As soon as you move the screen cursor 
on to one of the four edges or corners, it will 
change into a white double-headed arrow. If you 
now click the edge, you can move the trackball 
towards the centre of the picture to set a new 
position for the edge of the photo (e.g. a little 
above the hairline of the desired person). Do 
not crop the picture too tightly, as the edges 
will frequently be invisible when displayed on a 
monitor. Once you have specified the position, 
click the left-hand trackball button to confirm it. 
You will see that the “cropped edge” appears as 
a darkened area in the background.
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Now apply cropping to all four edges. You do 
not have to be too exact. We shall deal with 
fine cropping later. The cropped parts of a 
photo have not really been cut off. They can be 
restored at any time.

To carry out “Fine cut”, click the appropriate 
button on the lower edge of the picture, so that 
a tick appears. Then click again on the white 
double-headed arrow on the desired edge to 
see an enlargement of the area in which you 
have clicked. When you have fine-cropped all 
four edges, click “Ok” to return to the “Format” 
menu window. Move the trackball until the edge 
is in its correct position and click the left-hand 
trackball button so that you see the normal 
display again.

Exit from this menu by clicking the menu 
symbol in the lower right-hand corner and click 
the “Image processing” button in the main 
menu window. You will notice that the new 
menu window is similar to the previous one. 
Only the “Edit images” area is different. We are 
now going to consider this area. Click “Control 
images” to access a new menu window. 

You will see your cropped photo in large format. 
There are three symbols on the left-hand edge 
of the menu. 

Activate the upper one first, so that you can 
make brightness, contrast and colour saturation 
settings. Experiment with the three sliders until 
the desired settings are achieved. The symbol 
in the middle represents gamma correction. You 
can use this function to adjust the brightness 
without compromising the contrast (white will 
remain white and black will remain black).

Set the desired result here too. 
These two functions correspond to the familiar 
long-term “Control image” effect. The lower 
button corresponds to the long-term “Control 
color” effect, as you can specify new settings 
for red, green and blue here. Should you wish 
to return to the initial (cropped) photo, you can 
cancel all your settings in this menu window by 
clicking “None”.

You can save all the desired changes after 
making them, if you wish. To do this, click 
“Archives” and then  “Save” in the window 
which then opens. Enter the desired name for 
the filter which you have created and exit from 
the archive. When you have exited from the 
“Control images” sub-menu window by clicking 
“Ok”, you will see that the filter has already 
been applied to your photo.

Now exit from the menu window by clicking 
the menu symbol or on the right-hand trackball 



18 19

button.
Then click the “Print, Export” button in the main 
menu window. You can save your photo on your 
memory card in the menu window which then 
appears. To do this, click the “to memory card” 
button and select the desired memory card and 
quality in the window which appears. When you 
have confirmed your selection with “Ok”, please 
enter a name for the photo in the “Save image” 
window. After confirming with “Ok”, the photo 
will be stored on the card inserted.

You can then print your photo, if you have 
connected a suitable printer. To do this, access 
“Printer settings” and select the size of your 
printout from three different options. As this is 
only an example for tutorial purposes, select size 
“15 x 10”. You can then make any corrections 
to brightness, contrast and colour saturation for 
printing. After you have confirmed the settings 
with “Ok”, click “Print” under “Export images”. 
Your photo will be printed once you have clicked 
on this button.

If the printer will not start, you will see an 
appropriate warning message telling you to 
check all the cables, the paper and cartridge. If 
you have only installed the demo version of the 
Photo-Studio program, you will not be able to 
use the Print function.
If there are photos on the list, you can open 
the “Archives” in the “Cotrol images” menu 
window later and then click “Load”. A window 
will appear in which you will see the current 
photo on the left. There is a list containing 
the saved filters on the right-hand side. When 
you have activated a filter there, you will see 
that your photo will be divided in the middle, 
whereby the right-hand side of the photo will 
appear with the filter applied to it. If you are 
satisfied with the result, confirm it by clicking 
“Ok”.

6.2 Retouching a photo

In this tutorial you will learn how you can 
retouch flaws in your pictures. Start “Photo-
Studio”, insert a memory card into a drive and 

click “Import” in the main menu window. In 
the menu window which then opens, use the 
“Memory card” button to select the card type, 
so that the pictures on the card are shown in the 
upper section of the menu window. Now click a 
photo which contains a flaw. Select the “Mark 
actual image” function and then click the “Load” 
button.

Now access the main menu again and click 
“Format” to make any changes such as 
“Description”, “Rotate” or “Crop”. Please refer 
to the previous section for the precise use of 
these functions.

Exit from the “Format” menu by clicking the 
menu symbol in the lower right-hand corner and 
click the “Image processing” button in the main 
menu window. 
If you have already loaded several photos, 
ensure than the one to be edited is in the active 
frame. Click the “Retouch” button to access 
a new menu. Your photo will be displayed in 
large format and you will be prompted to select 
a detail which you want to retouch. Move the 
trackball until the box shown is located in the 
desired position (i.e. over the flaw). After you 
have confirmed the position by clicking the left-
hand trackball button, you will see the selected 
detail enlarged. A new button bar will also be 
displayed at the bottom of the screen.

You can now begin to retouch the flaws in your 
picture.
Click the coloured box on the left to open a 
window in which you can specify a brush for 
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retouching. Pre-defined square brushes are 
located on the upper row and round brushes 
in the lower row. Select the desired brush 
by clicking the appropriate box and specify 
its appearance with the attributes “Blur” 
and “Size”. The right-hand side provides a 
“Preview” of the settings made. We recommend 
that you first select a medium-sized, round 
brush. 
When you have created a brush, confirm your 
selection by clicking on “Ok”. You can then 
specify whether your copying brush is to be 
“relative” (i.e. the selected source area to be 
copied remains at a constant distance from 
the target area to be retouched) or “absolute” 
(the source area to be copied is stationary). 
Assuming that the flaw is on the sky (see 
illustration), you can simply use the same brush, 
as the sky is big enough to allow it to be moved 
to and fro. However, if the flaw is in part of a 
tree, you should select the absolute brush, as 
even a small movement will leave the surface 
area of the tree and could accidentally copy the 
area alongside on to the tree.

When you have selected a function and clicked 
on the appropriate button, you will see a green 
stamp symbol. Move the trackball until the 
stamp is over the area to be copied and confirm 
this selection by clicking the left-hand trackball 
button. After the stamp symbol has disappeared, 
move the ball until the stamp symbol, now red, 
is over the area to be retouched (the flaw). When 
you have reached the desired position, click the 
left-hand trackball button and move the trackball 
to and fro to copy the selected area. Clicking the 
left-hand trackball button will stop the copying 
process. You can now select another point to be 
retouched and start copying. Then retrieve the 
button bar by clicking the right -hand trackball 
button. The retouching which you have carried 
out will be stored in the picture by clicking the 
“Save image” option.

Then click “Exit” to exit from the menu.
Of course, you can also use the Retouch function 
to change pictures. For example, you can 
duplicate a person and insert them elsewhere 
in the picture. Alternatively, you can simply 
“delete” the grey clouds from the sky. With 
a little practice you will achieve astonishing 
results in no time.

6.3 Collage

This example shows you how to produce a 
collage of your photos, which you can then 
process for a slide show.
You must already have several photos loaded 
into the system. 
Run “Photo-Studio” and click “Collage” in the 
main menu window.
A window will open in which you will see a 
button bar and a white box, which will form a 
frame for your collage.
First click the “Settings” button and, when the 
window opens, select the “Snap to grid” option. 
The “Grid distance” should be 5.0 mm.
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Then click the coloured box next to “Background 
color” to select the desired colour for your 
“Collage” background from the paintbox. For 
example, select a pale, restrained colour here.

Click “Ok” to close the “Settings” window, 
then click the “New image” button to open a 
window in which you can select a photo from 
your list. Select the photo of your choice and 
click “Ok” to confirm. A cross with a small box 
will appear. Move the trackball until the cross 
(which represents the top left-hand corner of 
the box) reaches the desired position (e.g. in the 
upper left-hand corner of the background) and 
click the left-hand button to confirm. Now move 
the trackball again to determine the size of the 
box (e.g. 60.5 x 40.00 mm) and thus the position 
of the lower right-hand corner and click “Ok” to 
confirm. You will then see that the photo of your 
choice fills the box you have just drawn.

Of course, you can also reposition the box 
later. To do so, activate it and click the left-hand 
trackball button again as soon as the cursor 
turns into a hand. A cross will appear and you 
can move the ball until the box reaches the 
desired position. Click the left-hand trackball 
button to confirm the position. You can also 
adjust the size of the box by positioning the 
cursor on an edge or corner, so that it changes 
into a double-headed arrow. Then click the left 
trackball button and move the ball until the box 
reaches the desired size.  Click the left-hand 
trackball button to confirm the setting.

Now you can begin editing.
To do this, click “Edit image” to retrieve a new 
button bar, where you can select the “Rotate 
image” function. Now move the trackball to 
the left so that the picture tilts to the left. The 
angle will be displayed at the edge of the 
screen. Select a setting of 15° here. Then click 
the “Border” button to create a frame for your 
photo.

A button bar will then open, where you can 
select the settings for the frame. Click the colour 
box to open the “Palette” window, which offers 
a selection of colours, patterns and shades 
for creating the appearance of the box. Click 
“Change color” on the left-hand side to open 
the colour box, where you can select bright red. 
Click “Ok” to confirm and click “Ok” to exit the 
“Palette” window. Now set the “Border width” 
to  0.8 mm and “Blur” to 30%. Then click the 
“Shadow” button. Select the “Color” black 
with 60% transparency, for “Direction” select 
the arrow pointing down to the right and a 
“Distance” of 3.0 mm.

When you have made these settings, double-
click the right-hand trackball button to return to 
the “Collage” main menu window. Select the 
“New image” function and select another photo 
in the selection window. Click “Ok” to create 
a box of the requisite size and in the desired 
position for the photo. You can superimpose 
photos on top of each other, using the “to front” 
und “to back” buttons to change the position at 
any time.
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Select the desired rotation, frame or shadow 
settings for the new photo.

Add, position and edit as many photos as you 
wish in this way, to produce a full collage.

If you are satisfied with the result, click “Create”. 
A window will appear in which you can enter 
the desired length of the scene to be generated. 
When you have made your selection, click “Ok” 
to confirm and the scene will be processed.

When you exit the program, you will see the 
collage scene at the end of the scene bin of the 
“Edit” menu window. After you have added the 
scene to the storyboard, you can add special 
effects or  titles to the scene, for example.

6.4 Panning across an individual photo

This example shows you how to simulate a 
video recording by panning.
Run “Photo-Studio”, load a photo of a 
landscape scene (if you have not already done 
so) and open the “Animation” menu window.
You will see a selection window showing all the 
photos which have already been loaded. Select 
a landscape photo and click “Ok”.
You will see your photo in the foreground 
with a superimposed button bar. Above your 
photo, you will also see a box round a point, 
representing the detail of the photo from the 
subsequent camera position. 

If you want to reduce the size of this detail of 
the photo, i.e. zoom in on the content of the 
box, first position the cursor on one of the four 
corners, so that a white double-headed arrow 
appears. Click the left-hand trackball button and 
move the ball until the box reaches the desired 
size.  Then click “Ok” to confirm.

You can then decide whether you are satisfied 
with the detail of the photo already set. If not, 
position the cursor on the point in the box 
(starting point of the track) and click the left-
hand trackball button so that the point turns 
blue.  Then move the trackball until the point 
(and box) are in the correct position. However, 
the box should still be on the left-hand edge of 
the picture. Then click the left-hand trackball 
button again to confirm the position.
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You will see that there is already a second point, 
i.e. the end of your track, on your photo. Make 
sure that this is on the right-hand edge of the 
picture and that the size and position are correct. 
Then click the “Preview” button to see the 
camera track across your photo.

Tip: If you want the camera track to be slightly 
“livelier”, simply click the left-hand trackball 
button at any point on the dotted track, so that 
a small pivot appears. Then move the trackball 
until the pivot is in the correct position and click 
again on the left trackball button. Add as many 
pivots as you wish to extend the camera track.

If you are satisfied with the result seen in the 
“Preview” window, it can now be processed. 
After processing, which may take some time, 
you will see your finished animation at the end 
of the scene bin in the “Edit” menu window.

6.5 Animated track across a group 
photo

This example enables you to practise the action 
you have already learned to create a camera 
track.  You need a photo of several people. The 
example uses a group photo showing three 
people, positioned in the centre of the picture.

After you have loaded the photo, click 
“Animation” in the main menu window and 
select the group photo in the selection window 
which then appears. 

A warning will appear that the animation 
created on the other photo will be lost. However, 
as the previous animation has already been 
processed, you can click “Ok” in this case.  The 
“Animation” menu will then appear. There are 
two points on your photo again, i.e. the start 
and end points. Now click the left-hand trackball 
button on the green start point (so that it turns 
blue) and move the trackball until the point 
reaches the centre of the photo. Click the left-
hand trackball button to confirm the position. 
You can now change the size of the box and thus 
the size of its content. In the preceding example, 
you learned to do this by selecting the corners 
directly. 
Here you will learn a new method. Click the 
“Edit” button to display a new button bar. 
The content of the box will be displayed in the 
background. Now select the “Zoom” function. 
You will see that the factor is “1.00”. Move the 
trackball to the right or left to zoom in or out. All 
three people should be within the box. Click the 
left-hand trackball button to confirm the setting. 
You can then use the “Position” button to 
determine the exact position of the box on your 
full photo and “Zoom” again to define the size 
of the selection, if necessary.

Click “Ok” to exit the “Edit waypoint” menu 
window and select the “Append new” function. 
You will see a new (yellow) point appear just in 
front of the end point. Double-click this point, so 
that it changes to green then blue. Then move 
the trackball until the point is on the head of 
the first person (on the left). Click the left-hand 
button to confirm and use the “Zoom” function 
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to reduce the size of the box until the head of the 
person has a generous frame round it. 

Click “Append new” again, position the new 
point on the head of the second person and 
adjust the size of the box as required. Continue 
as described above. Then add another point, 
position it on the head of the third person and 
frame the head.

Finally, double-click the yellow end point to 
turn it blue. Move the trackball to pull the end 
point into the centre of the photo and position 
it beside or on the start point. Then enlarge the 
box until all three people are inside it again.

Now view your result under “Preview”.
If you are not satisfied with the result, you can 
make corrections before it is processed. For 
example, you yourself can determine the length 
of time the camera stays on one head. See 5.2.3 
Animation for details.

Your result can then be processed. After 
processing, which may take more time in this 
example, you will see your finished animation 
at the end of the scene bin in the “Edit” menu 
window.

6.6 Slide show consisting of several 
photos

This example guides you step by step through 
creating a slide show from your individual 
photos. You must already have several photos 

loaded into the system. 

Click the “Gallery” button in the “Photo-Studio” 
main menu window.  The following menu will 
appear:

The photos loaded appear at the top in a list, 
and the board for the slide show appears at 
the bottom.  This board is comparable with the 
storyboard in the “Edit” menu window of your 
Casablanca. It shows the subsequent final result 
and the individual photos can be moved around 
using the scrollbar or slider and the photo in the 
centre frame is active.

Now select one of your photos from the list, 
activate it and click “Insert”. The default length 
(i.e. dwell time) of  the photo is 5 seconds 
which, of course, you can change at any time 
by clicking the “Length” button and set to a 
different time using the slider.

Then activate another photo and click “Insert”.  
As you are on the first photo in the board, you 
will be asked whether you wish to position the 
new photo in front of or behind the picture (as 
with the Storyboard prompt).
After you have added it at the end, position all 
the other photos required.
Of course, you can add other photos in the 
centre of the board by simply selecting the 
photo you want on the board and clicking 
“Insert”. The new photo from the top list will 
then be added to the board behind the active 
photo.
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If you have accidentally positioned the wrong 
picture, you can make corrections using the 
“Replace” or “Remove” buttons familiar from 
the Storyboard.

Then click “Create” and deactivate the “Create 
scene for each image” function. Then exit the 
“Photo-Studio” program.

You will see that the slide show you have just 
produced is in the scene bin of the “Edit” menu 
window and can be played like a normal scene.

Tip: In order to produce a more complex slide 
show, re-open the “Gallery” menu window in 
the “Photo-Studio” program. You will see that 
your board is still laid out the same way.

Click “Create” again, but this time activate the 
function for generating a scene for each picture. 
After exiting the program and identifying the 
individual scenes in the scene bin, add them 
to the Storyboard and go to the “Transitions” 
menu window.

Here you can add and process dissolves as 
required so that each individual photo in your 
slide show then has an appropriate transition.

Allow the transitional effects to be processed, 
then play the storyboard in the “Edit” menu 
window.

You can now concentrate on adding sound to 
round off your slide show.
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